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How Summer Fellowship Connects to ETP 
I am learning about digital media and how it's being used in the community and exploring possibilities on what 
additional uses there could be.  I am sitting in and somewhat evaluating training classes for teachers.  This will give 
me a gauge of the training I might be able to provide.  I am getting a feel for the partnerships that can be created by 
business and education institutions. 

Need for Technology?  Technology as Needed? 
1)  Teachers will learn technology on an "as needed" basis.  By helping teachers recognize the creativity sparked 
by using digital media in a classroom, I am hoping that they will find a "need" to learn the technology.  There is a 
steep learning curve for teachers who did not grow up in the digital age.  Training schools do not adequately 
prepare teachers for the technology that comes as second nature to the students.  Teachers (and students) don’t 
have equal access to the latest technology – cell phones, digital cameras, MP3 players, DV Cameras, software, 
and high end computers.  Not only does a digital divide exist in equipment, but in skills as well.  There is no 
panacea for this problem.  BUT, every little change counts.  By meeting teachers where they are at – (in skills, 
interest, and location), I am hoping that they will incorporate some new technology in their curriculum next year.   
 



2)  Students, especially underprivileged students without access to the latest technology, will be able to develop 
their own voice by completing open ended products which communicate what they have learned in their classes 
through projects like photo essays, digital portfolios, mini documentaries, and content videos.  Ideally, I hope to be 
able to provide the technical training needed for the students to complete these projects in the library.   
 

STANDARDS ADDRESSED 
NBC Adolescence/ Young Adult Science 
III. Understanding Science Teaching 
Accomplished Adolescence and Young Adulthood/Science teachers employ a deliberately sequenced variety of 
research-driven instructional strategies and select, adapt, and create instructional resources to support active 
student exploration and understanding of science. 
V. Sustaining a Learning Environment 
Accomplished Adolescence and Young Adulthood/Science teachers create safe, supportive, and stimulating 
learning environments that foster high expectations for each student’s successful science learning and in which 
students experience and incorporate the values inherent in the practice of science. 
XI. Developing Collegiality and Leadership 
Accomplished science teachers contribute to the quality of the practice of their colleagues, to the instructional 
program of the school, and to the work of the larger professional community. 
NBC LIBRARY MEDIA 
V. Leading Innovation through the Library Media Program 
Accomplished library media specialists lead in providing equitable access to and effective use of technologies and 
innovations. 
VI. Administering the Library Media Program 
Accomplished library media specialists plan, develop, implement, manage, and evaluate library media programs to 
ensure that students and staff use ideas and information effectively. 
How Library Media Specialists Grow as Professionals 
VIII. Professional Growth 
Accomplished library media specialists model a strong commitment to lifelong learning and to their profession. 
X. Leadership, Advocacy, and Community Partnerships 
Accomplished library media specialists advocate for the library media program, involving the greater community. 
TECHNOLOGY (K-12)  (Although neither NBC or State standards, part of National Education Standards) 
NT.K-12.1 BASIC OPERATIONS AND CONCEPTS   
Students demonstrate a sound understanding of the nature and operation of technology systems.  



Students are proficient in the use of technology.  
NT.K-12.2 SOCIAL, ETHICAL AND HUMAN ISSUES   

• Students understand the ethical, cultural, and societal issues related to technology.  

• Students practice responsible use of technology systems, information, and software.  

• Students develop positive attitudes toward technology uses that support lifelong learning, collaboration, personal pursuits, 
and productivity.  

NT.K-12.3 TECHNOLOGY PRODUCTIVITY TOOLS   

• Students use technology tools to enhance learning, increase productivity, and promote creativity.  

• Students use productivity tools to collaborate in constructing technology-enhanced models, prepare publications, and 
produce other creative works.  

NT.K-12.4 TECHNOLOGY COMMUNICATION TOOLS   

• Students use telecommunications to collaborate, publish, and interact with peers, experts, and other audiences.  

• Students use a variety of media and formats to communicate information and ideas effectively to multiple audiences.  
NT.K-12.5 TECHNOLOGY RESEARCH TOOLS   

• Students use technology to locate, evaluate, and collect information from a variety of sources.  

• Students use technology tools to process data and report results.  

• Students evaluate and select new information resources and technological innovations based on the appropriateness for 
specific tasks. 

NT.K-12.6 TECHNOLOGY PROBLEM- SOLVING AND DECISION-MAKING TOOLS   

• Students use technology resources for solving problems and making informed decisions.  
Students employ technology in the development of strategies for solving problems in the real world. 

Resources for Implementation 
● Join School’s professional development committee 

 This committee is responsible for setting up the professional development opportunities available to the 
staff.  As a member, one can proactively push for technology training to be on the agenda.  In addition, each 
member becomes more keenly aware of the resources teachers want accessible as well as the resources that are 
already available within the staff.  Since this committee reviews the pre and post surveys of all professional 
development activities, the effectiveness of the programs can be evaluated and improved to meet the needs of the 
staff better. 
● Create Training Schedule 

TEACHER TRAINING 
Teachers need an incentive for training.  Teachers also need to know that their time is an asset.  Teachers need as 
much individual attention as students do.  With that in mind, the more personal support that can be offered, the 



better.  It is important for the Library Technology Teacher to be keenly aware of the current curriculum used in the 
classroom and offer technology solutions to enhance the good work currently taking place.   
 Prep Period Trainings – After identifying the technology “needs” of the staff, setting up prep period 
trainings would allow for teachers to come attend more personalized workshops on how to use certain software 
applications in their classroom.  Evite invitations could be sent out to select teachers so that they will feel honored 
and maybe “obligated” to attend.   
 Personal Prep Period Trainings – After teachers have attended the basic Prep Period Trainings and may 
have found activities in which they would like to integrate the software more into their curriculum, I could spend time 
researching how to do it more effectively, produce student handouts, and spend personal time with teachers in 
creating technology based lesson plans.   
 External Training recommendations (ideally ones which offer CEU credits) – Teachers need to be 
informed of technology training opportunities.  At these trainings, they may encounter teachers outside of their own 
schools and begin a collaborative relationship.  They may learn new ideas, share in struggles and triumphs in ways 
that would not be possible on the school site. 

• RAFT Workshops - http://www.raft.net/index.php?pg=workshops 

• Adobe Teach the Teacher Workshops – (FREE workshop AND CEU units) http://www.raft.net/index.php?pg=ttt 

• Intel Teach for the Future Program - http://www97.intel.com/education/teach/ 
STUDENT TRAINING  
After the school instituted a new bell schedule - http://hhs.fuhsd.org/info/bells.htm - students have a voluntary 30 
minute tutorial period from Tuesday to Friday.  Voluntary simply means that they can CHOOSE which classroom 
they will spend their 30 minutes in.  These minutes are supposed to be instructional minutes.  Theoretically, 
teachers are able to give students more individualized help during this period of time.  Ideally, students who do not 
“need” help use this time to complete homework, work on group assignments, or read for pleasure (a book of their 
choice to promote literacy).  Seemingly, this would be a good time to institute voluntary technology training classes.  
Technology is often hard to teach during content period classes because there is just TOO MUCH CONTENT to 
cover.  With that in mind, the LTT can work alongside teachers to support their curriculum without taking away 
precious classroom minutes.   
 The library is already equipped with a teaching classroom of 32 computers.  Students could sign up for a 
variety of classes.  Ideally, the LTT has already consulted with departments to see which technology skills might be 
useful.  Teachers could send their students to attend these classes and have some sort of way to keep the students 
accountable – through a sign in sheet or a sample activity that was completed, turned in, and logged.  Some 
sample classes could include: 
 



● English – Word Processing for Writing Essays 

● Social Studies – Creating Documentary Films 

● Math – Inserting Graphs, Tables, Formulas in Spreadsheets 

● Science – Basics of a Lab Report – merging word processing and database information 

● General – Giving a Multimedia Presentation  

● General – Researching on the Internet  
Setting Up A Multimedia Editing Station  
Develop a budget plan for obtaining the following materials. 

Hardware 

• Computer 

• CD Reader/Writer 

• Digital Cameras - still, movie  

• DVD Reader/Writer  

• Scanner  

• Software Manuals  

Software  

• Adobe Photoshop Elements - images, drawing  

• Adobe Premiere Elements - movie editing  

• Macromedia Dreamweaver - web editing  

• Macromedia Flash - web animation  

• Macromedia Freehand - web drawing  

• QuickTime - web movie plug-in  

 
● Explore community partnerships (grant writing opportunities, corporate sponsorships, working with community 

colleges, middle schools, universities) 
http://www.ed.gov/programs/teachtech/index.html 
http://www.globalclassroom.org/grants.html - some links missing 
http://www.lib.msu.edu/harris23/grants/2comptec.htm 
http://www.giftsinkind.org/NewHome/default.asp - product philanthropy - to receive software donations, etc… 
(ADOBE DONATES PRODUCTS TO THIS ORGANIZATION) 

Implementation Plan (Schedule of Implementation) 
August / September  

• Meet with school's professional development committee  

• Create a process in which teachers can use the LTT so that they do not need to take time during their classes to 
"TEACH" the technology.   

By End of First Semester 

• Create a media editing station in the library.   

• Create checkout process of equipment – eg. digital cameras 
 



Ongoing  

• Create curriculum for Teacher Training Sessions 

• Create curriculum for Student Training Sessions (Appendix 1) 

Plan for Assessing or Evaluating the Outcomes 

Pre-assessment 
1)  Teacher/ Department Technology Use Survey – to see how technology is currently being used, expectations, 
and future possible use.  (Appendix 2) 
2)  Computer skills survey - to discover what teachers and students do and do not know. (Appendix 3) 

Post - Assessment 
1)  Teacher/ Department Technology Use Survey – to see if there has been a change is how technology is currently 
being used, expectations, and future possible use. 
2)  Computer skills survey – give the same survey as the pre-assessment and see if teachers/students feel more 
comfortable with technology as a whole. 
3)  Post Training Skills assessment - to prove to teachers that the students attended a training session and 
successfully completed it. 
4)  Compile Quantitative data of technology use. 
 (sample information to include: # of projects previously done without computers and now using computers, 
# of classes which check out computer labs for classwork, software being used, # of teachers/students attending 
training sessions, # of training sessions offered, etc.) 



USING WORD & EXCEL – Basic Skills for lab reports 

WORD  

Margins 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Line 
Spacing 
 
 
 
 
Spell Check 
 
 
 
 
 
 
 
 
 
 
 
 
Creating A 
Table 
 

1) Go to “File” menu, select “Page Setup”  
2) With the “Margin” tab, set all margins at 1” with the arrows or click in the box and type  

“1” directly in the box. 
3) Click “OK” on the bottom of the pop up box when done 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1) In the “Format” menu, select “Paragraph” 
2) Select the box under “Line Spacing:” and select appropriate value (1.5 and 2 recommended)” 

3) Click “OK” on the bottom of pop up box when done 
 
 
1) Press F7 key    
 or 1)  In the “Tools” menu, select “Spelling and Grammar” 
  2)  Once suggestions show up, click either “Ignore” or “Change” after  

selecting the word you want to replace it with 
 
 
 
 
 
 
 
 
 
 
 
 
1) In the “Table” menu, select “Insert Table” 
2) Enter the needed rows and columns 
3) Click “OK” on the bottom of pop up box when done 
 

To add gridlines to table: 
1) In the “Table” menu, select “Table AutoFormat” 
2) Scroll down possible Formats and choose the format most appropriate.   
(“Grid 1” recommended and useful for most situations ☺) 

WU 
usingword&excel 



EXCEL 
 
Creating A 
Graph 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Line Graphs 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Placing 
Graph Into 
Word 

1) Enter the data into different columns or rows 
2) Highlight data 
3) Select the graphing icon on the toolbar or in the “Insert” menu, select “Chart” 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4) (Step 1 of 4) Select on the Chart Type that is most appropriate for the data 
5) Click on “Next>” button 
 
After selecting “line graph” or “XY Scatter” (usually used when you want to set X axis): 
1) Click on “Press and Hold to Preview sample” to see if it looks like what you want 
2) Click on “Next>” button 
(Step 2 of 4)  
3) With “Data Range” tab selected, choose if series is in Row or Columns 
4) Change the “Data Range:” if incorrect by selecting the icon on the right hand edge of the box and 
 highlight the data from the worksheet  
5) With the “Series” tab selected, change the “Category (X) labels” the same way as “Data Range:” 
6) If there are no names for each series, select the “Series” and type name in “Name” box 
7) Click on “Next>” button 
(Step 3 of 4) – Chart Options  [Scan through all the tabs to format] 
8) With “Titles” Tab, type titles and labels for the graph (USTA) 
9) With “Axes” Tab, generally have “Category (X) axis” and “Value (Y) axis” checked 
10) With “Gridlines” Tab, Category (X) axis = vertical lines, Value (Y) axis = horizontal lines 
11) With “Legends” Tab, select placement of Legend (not always needed - ie. one set of data)  
12) With “Data Labels” and “Data Table”, select to personal preferences 
13) Click on “Next>” button 
(Step 4 of 4) – Chart Location 
14) If graph is to be embedded in a Word document, select “as object in Sheet ___,” otherwise,  

select “As New sheet in”   
15) Click on the “Finish” button 
 
⎝ FOR ALL OTHER TYPES OF GRAPHS 
The instructions for other types of graphs follow the same steps, but different options may be available 
depending on the data that needs to be displayed.   
 
1) Select graph with mouse (8 black squares should be surrounding graph box) 
2) In “Edit” menu, select “Copy” (Ctrl+C) 
3) Toggle over to Word (Alt+Tab if both are open) 
4) Position cursor to where graph will be placed 
5) In “Edit” menu, select “Paste” (Ctrl+V)  

WU 
usingword&excel 



Content Area ______________________   Name (optional) _______________________________________  
 

Teacher Technology Use Survey 
Which of the following are among the objectives you have for student computer use? (Check ALL that apply) 
1. Mastering skills just taught  

2. Remediation of skills not learned well  

3. Expressing themselves in writing  

4. Communicating electronically with other people  

5. Researching ideas and information  

6. Analyzing information  

7. Presenting information to an audience  

8. Improving computer skills  

9. Learning to work collaboratively  

10. Learning to work independently  

Other (describe):  

 

Which 3 objectives from the list above are your most important ones? (Write 3 numbers from above list.) 
 
a. ____________  b. ____________   c. ____________ 
 

Which of the following are among the objectives you have for teacher computer use? (Check ALL that apply) 
1. Record or calculate student grades  

2. Make handouts for students  

3. Communicating electronically  

4. Write lesson plans or related notes  

5. Researching ideas and information   

6. Get media (pictures, movies, audio) from the Internet for use in lessons  

7. Use camcorders, digital cameras, or scanners to prepare for class  

8. Exchange computer files with other teachers  

9. Presenting information to an audience  

10. Creating and maintaining a class website.  

Other (describe):  

 

Which 3 objectives from the list above are your most important ones? (Write 3 numbers from above list.) 
 
a. ____________  b. ____________   c. ____________ 
 
 
 



Do you agree or disagree with the following statements regarding the advantages of using computers in teaching?  
 Agree Disagree 
1. Students create better-looking products than they could do with just writing and other traditional media   

2. Computers provide a welcome break for students from more routine learning activities.    

3. Students help one another more while doing computer work.   

4. Students take more initiative outside of class time--doing extra research or polishing their work.   

5. Students’ writing quality is better when they use word processing.   

6. Students work harder at their assignments when they use computers.   

7. Students are more willing to do second drafts.   

8. ’Average’ students are communicating and producing in ways only ’gifted’ ones did before.   

Which statement do you AGREE most strongly with? (Write 1 number from above list.)  a. __________  

Do you agree or disagree with the following statements regarding the disadvantages of using computers in teaching?  
 Agree Disagree 
1. Computers are too unpredictable - they "crash," or the software doesn’t work right.   

2. Many students use computers in order to avoid doing more important school work.   

3. Many students are not careful enough with this expensive equipment.   

4. It is difficult to integrate computer activities into most of my regular lesson plans.   

5. Often too many students need my help at the same time.   

6. Students often get so wound up; I can’t get them to settle down afterwards.   

7. A teacher has to give up too much instructional time to teaching computer skills instead of content.   

8. Students can cheat easier—copying work and turning it in as their own.   

Which statement do you AGREE most strongly with? (Write 1 number from above list.)  a. __________  

In general, when you ask for support, what category does it fall into? 
 Technical (troubleshooting equipment/software) 

 Instructional (integrating technology into lessons – redeveloping lesson plans) 

 Training (learning how to use equipment/software) 

What equipment/software would you like to have access to? 

 

What objectives (teacher or student) would this equipment/software meet? 

 

 

Additional Comment(s): 
 



DATE _______________________________     NAME ______________________________ 
 
 

Computer Skills Checklist 
TASK:  Place a 1, 2, 3, or 4 to best describe your skills. 
 

1 = No knowledge   2 = Some knowledge/Need help 3 = Comfortable Using 4 = Can teach others 
 

HARDWARE 
•  Keyboarding skills (type at least 40 words per minute)  

•  Aware of special keys and what they do – Esc, Arrows, Enter, Ctrl, Alt, Fn, Home, End  

•  Aware of different functions with right click, left click, or double click of mouse  

•  Functionally attach peripherals to computer (projector, printer, scanner, camera, key drive, etc.)   
FILE MAINTENANCE 

• Open Windows Explorer and find proper directory   

• Create and navigate directories and subdirectories   

• Delete files   

• Rename files  

• Copy or move files to a new directory  

• Copy or move files to a new drive, including to and from a disk (floppy, key drive, CD, etc.)   

• Searching using Find File from the Start Menu  

• Save as a new file name & know where the file is saved   

• Save as a new file format, and know when and why to use this feature   

• View file types   

• View file sizes   

• Determine how much free space is available on a hard drive; know what to do if your hard drive is too full  
OPERATING SYSTEM 

• Minimize or maximize a window  

• Tile or resize a window  

• Use Toolbars   

• Open multiple programs   

• Switch between multiple programs  
WORD PROCESSING 

• Page formatting (margins, tabs, indents, paragraph alignment, paper size and type)   

• Text formatting (font type, size, bold, underline, color, etc.)   

• Hiding/ Showing tool bars  

• Spell checking, Using Thesaurus  

• Print preview  

• Save and Open files    

• Use of shortcut keys  

• Negotiating multiple open word processing documents   

• Search and replace words  

• Add/delete bullets and numbers   

• Cut/paste text   

• Undo/redo text   

• Text Alignments (center, right, left and justified)   

• Create/edit tables  

• Create/edit columns  

• Set/delete tabs   

• Add/View toolbars   

• Insert pictures, charts, graphs   

• Insert/create WordArt   

• Header/footer (page numbering)  



PRINTING 
• Find a printer   

• Shift between local and network printing or between network printers  
EMAIL 

• Add, open, and save attachments   

• Print messages and attachments   

• Create personal address lists for Email    

• Forward Mail   

• Delete messages in in-box, out-box and sent-box   

• Create folders for mail storage   

• Change preferences   
INTERNET USE 

• Locate and use major search engines   

• Understand basic search commands (&/or/not/+; wildcard(*); phrase searching (" ")   

• Add, delete, and organize bookmarks with Personal Toolbar   

• Save documents as *.html or *.txt file   

• Copy and paste text into a document or file   

• Copy and insert images into a document or file   

• Evaluate Web site authenticity, bias, accuracy, currency, authority, etc.   

• Understand copyright/fair use issues   

• Understand School Internet use agreement and enforcement standards (in Student Handbook)  
SPREADSHEET 

• Open / Save files   

• Sort Data   

• Printing  

• Format data (text, date, time, currency, border, font, alignment, numbers)   

• Creating/editing charts, graphs   

• Renaming sheets   

• Borders/shading   

• Identify labels/values   

• Change font   

• Cut/paste   

• Create/edit simple formulas  
POWERPOINT 

• Open/ Save Presentations   

• Create Slides   

• Format text   

• Drawing and Manipulating objects   

• Inserting pictures, audio clips, video clips  

• Creating Backgrounds  

• Using Hyperlinks  

• Rearrange slides in presentation   

• Making note pages and handouts   
DIGITAL MEDIA 

• Use a digital camera to take pictures  

• Use a digital video camera  

• Transfer pictures from camera to computer  

• Transfer video from camera to computer  

• Edit Pictures using software  

• Edit Video using software  

• Upload pictures/video onto a website  




